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eDirectory and LDAP Authentication with PANOS

One of the most useful features of the Palo Alto firewall is its ability to map usernames to IP
addresses. Once the firewall knows the names associated with IP addresses, the firewall can 1)
log this information, and 2) control traffic based upon a particular username or group. Prior to
PANOS 3.1, the following methods existed:

 Transparent authentication: the firewall can automatically retrieve username and IP
mappings from Active Directory domain controllers, using the Active Directory User-ID
agent. In this case, the user previously logged into the domain, and so is not prompted
for credentials by the firewall.

 Interactive authentication: the firewall can prompt the user for their username, and
then authenticate the user via RADIUS or a local user database. This would be the case
in the following situations:

o the users are running Mac or linux clients (called “captive portal”)

o the users are connecting to the firewall over our SSL VPN

o the users are trying to login to the firewall GUI as an administrator

With the release of PANOS 3.1 and the support for LDAP, the above methods are extended to
include:

 Transparent authentication: the firewall can automatically retrieve username and IP
mappings from Active Directory domain controllers (using the Active Directory User-ID
agent) or from eDirectory servers (using the new eDirectory User-ID agent). Please
note the new User-ID agent is only compatible with eDirectory 8.8 and due to
unique login information that eDirectory tracks.

 Interactive authentication: the firewall can prompt the user for their username, and then
authenticate the user via RADIUS, a local user database, or an LDAP server.

This document will cover configuring transparent authentication via an eDirectory server, as well
as interactive authentication via an LDAP server. Thus this document has two parts:

 Part 1: Obtaining user authentication information from an eDirectory server transparently
with the new User-ID agent.

 Part 2: Configuring LDAP authentication with an Active Directory server for use with
captive portal, SSL VPN, or firewall GUI access.
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Before we get into the actual setup I would suggest you have a local LDAP browser. This
will help to verify the settings you will be using for the User

Throughout this examples are done using JXplorer,
be obtained here: http://jxplorer.org/

Part 1: Transparently obtaining user authentication information from
eDirectory

Novell’s eDirectory is a directory service that fully supports LDAP queries.
eDirectory is that when a user authenticates to it the source IP address
in the directory in the fields: networkAddress
The new User-ID agent was developed to
can transparently map users to their IP addresses.

One major difference between the Palo Alto LDAP
agent is that it does not handle pushing group informatio
Our new LDAP support in PANOS is used to query the directory, build list of groups for policie
and map users to groups. Because of this, p
support is configuring LDAP information on the PAN device.

Part 1a: Installing and configuring the User

1. Make sure you are running Novell eDirectory 8.8 or higher.
some LDAP functions that are not available in previous versions of eDirectory.

2. You will now install the new User
https://support.paloaltonetworks.com
Identification Agent section. You are looking fo

Download this .msi file to the
file while logged in as an administrator.
system account. The service name is “
management console.
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Before we get into the actual setup I would suggest you have a local LDAP browser. This
verify the settings you will be using for the User-ID agent and the PA firewall.

ut this examples are done using JXplorer, a free cross platform LDAP bro
http://jxplorer.org/.

Part 1: Transparently obtaining user authentication information from

Novell’s eDirectory is a directory service that fully supports LDAP queries. A useful feature of
user authenticates to it the source IP address and login time

networkAddress (in a proprietary binary format) and
ID agent was developed to be able to specifically read this information so that we

can transparently map users to their IP addresses.

the Palo Alto LDAP agent and the Palo Alto Active Directory
agent is that it does not handle pushing group information it merely maps users to IP addresses.
Our new LDAP support in PANOS is used to query the directory, build list of groups for policie
and map users to groups. Because of this, part of the process of implementing eDirectory

information on the PAN device.

Part 1a: Installing and configuring the User-ID Agent

Make sure you are running Novell eDirectory 8.8 or higher. The User-ID Agent uses
some LDAP functions that are not available in previous versions of eDirectory.

install the new User-ID agent. Login to your support account at
https://support.paloaltonetworks.com. Go to the Software section and then find User
Identification Agent section. You are looking for a version that ends in “

to the Windows server where the agent will run.
e logged in as an administrator. It will run as a local service under the local

service name is “User ID Agent”, as shown here in the Services

Before we get into the actual setup I would suggest you have a local LDAP browser. This
ID agent and the PA firewall.

LDAP browser that can

Part 1: Transparently obtaining user authentication information from

A useful feature of
and login time are stored

) and loginTime.
read this information so that we

Active Directory
n it merely maps users to IP addresses.

Our new LDAP support in PANOS is used to query the directory, build list of groups for policies
eDirectory

ID Agent uses
some LDAP functions that are not available in previous versions of eDirectory.

account at:
. Go to the Software section and then find User

r a version that ends in “-LDAP”.

. Install the .msi
under the local

User ID Agent”, as shown here in the Services

http://jxplorer.org/
https://support.paloaltonetworks.com/
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3. Once installed launch the User-ID Agent and select Configure. Configure the following:

 Device Listening Port: use the default. This port number is used for
communications between this agent and the PA firewall. Remember this port
number, you will need it when configuring the PA firewall.

 Enable the Network Address Allow/Ignore list. Add the networks for which you
want to monitor for user IDs. If there are terminal servers or other multi-user
machines, add those IP addresses to the Ignore list as we need to use the Terminal
Services Agent to track users on those systems.
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4. Next we need to configure our eDirectory settings. Select the eDirectory menu item on
the left, and the screen below will appear.

Complete the following fields:

 Server Enter the IP address of the eDirectory server you will be monitoring and
hit “Add”. If you have multiple servers to monitor, you need to configure the settings
at the bottom of the screen for EACH of the servers using the Copy Setting button
can simplify the process. There are several instances where you will need to enter
multiple eDirectory servers. If the directory is partitioned among servers you need to
make sure that each partition has a server configured. Also depending on how
quickly information is synchronized between servers you may want to add additional
servers to insure that user/ip mappings show up more quickly.

 Search Base This is the base DN (or root) of the directory where the agent will look
for users. In a very large deployment you can scope how much of the directory is
searched by setting the search base appropriately. In eDirectory this is typically in
the form of o=. Using JXplorer you can connect to eDirectory anonymously and
only specify the IP address and the default non SSL port as shown below.
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Hit OK and you will get to the following where you can expand the root objects to
determine your base DN. Also select Table Editor view to see the actual object type.
In this example our base is
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Hit OK and you will get to the following where you can expand the root objects to
determine your base DN. Also select Table Editor view to see the actual object type.

this example our base is o=lab.

Hit OK and you will get to the following where you can expand the root objects to
determine your base DN. Also select Table Editor view to see the actual object type.
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 Bind Distinguished Name and Password This is the fully distinguished name
(FQDN) of the user you will use to query eDirectory. This account does not need any
special privileges. You will need to enter the password for this account. You should
be able to browse to this anonymously as we did to get the BaseDN. Remember that
the fully distinguished name is built from using the entire hierarchy. In our example
that would be cn=Admin, o=lab.

 Server Domain Prefix (optional) This will be pre-pended to the user name
and can be useful if you are using multiple authentication sources. In our example
users would show up in the traffic logs as: mynds\username.

 Search Interval The default of 30 seconds should be fine but this can be adjusted if
necessary. One point here: after the first query to build the list of all currently logged
in users, subsequent queries only search for users entries that have been modified
since the last query.

No other fields should need to be modified as they are set to specifically work with
eDirectory.1 Keep the bind port at 636, and SSL must be enabled, as eDirectory does not
allow authenticated LDAP queries to be sent in the clear.

5. After entering the required information hit the Commit button to make our changes
effective.

You will be prompted to restart the service.

6. Now, view the agent logs to see what is happening with the agent. File -> Show Logs
will open a .txt file.

1 Note that if they do need to be modified, you should use an LDAP browser to determine what to set the fields to.
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At the bottom of that text file will be the latest debug information output from the agent,
scroll down to that. Examine the output under the header labeled “Service is being
started”. Here is an example log file:

You want to see the message “Connect succeeds on server x.x.x.x”, as highlighted above.
If you do not see that message, you will need to do some troubleshooting.

Helpful troubleshooting hints:

 If you see error 81 in the log, make sure that the bind port/SSL setting is
configured as needed.

 If you see error 93 in the log that may mean that there is some kind of
communication error. You may be running the wrong version of eDirectory, or
the base DN is not correct.
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 If you want to increase the amount of information logged, use File
menu to set the level to be more detailed (default level is “i
the service (File -> Restart Service)

 Note that this text file is not updated dynamically, so you will have to close it and
use the menu to view it again to see new information.

7. To verify the configuration we can select the Monit
user to IP mappings. The number of mappings will increase as the agent reads more
information from the LDAP server.

Once you see a list of users on this screen, that is confirmation that you have configured the
agent properly. You can now move on to configuring the firewall to talk to this agent.

Part 1b: Configuring the firewall to talk to the User

8. On the firewall GUI, select
the left. Under the User Identification Agent section hit the “
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If you want to increase the amount of information logged, use File
menu to set the level to be more detailed (default level is “info”), and then restart

> Restart Service)

Note that this text file is not updated dynamically, so you will have to close it and
use the menu to view it again to see new information.

To verify the configuration we can select the Monitor icon. On this screen we can see
. The number of mappings will increase as the agent reads more

information from the LDAP server.

Once you see a list of users on this screen, that is confirmation that you have configured the
properly. You can now move on to configuring the firewall to talk to this agent.

Part 1b: Configuring the firewall to talk to the User-ID agent

On the firewall GUI, select the Device tab, then select User Identification from the list on
the left. Under the User Identification Agent section hit the “Add” button. Set the Agent

If you want to increase the amount of information logged, use File -> Debug
nfo”), and then restart

Note that this text file is not updated dynamically, so you will have to close it and

or icon. On this screen we can see
. The number of mappings will increase as the agent reads more

Once you see a list of users on this screen, that is confirmation that you have configured the
properly. You can now move on to configuring the firewall to talk to this agent.

select User Identification from the list on
” button. Set the Agent
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Type “user-id-agent”. Give it a name set and fill in the IP address and the port you had
configured the agent to listen on (default port is 5007).

9. You will now enable User Identification on the appropriate zone. Choose the Network
tab, select Zones from the list on the left, and click on the zone
originates. At the bottom of the screen check

10. Commit your changes.

11. To confirm that the firewall is communicating with the agent, run this command:

10

Give it a name set and fill in the IP address and the port you had
listen on (default port is 5007).

enable User Identification on the appropriate zone. Choose the Network
he list on the left, and click on the zone where users’ traffic

. At the bottom of the screen check the box “ Enable User Identification

To confirm that the firewall is communicating with the agent, run this command:

Give it a name set and fill in the IP address and the port you had

enable User Identification on the appropriate zone. Choose the Network
where users’ traffic

Enable User Identification”.

To confirm that the firewall is communicating with the agent, run this command:
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12. To confirm that the user database was obtained from the agent, run this command:

13. At this point, the user IDs will appear in the Monitor tab
and target-user columns.

14. Now that we have gotten the basic User
Server Profile we will use later for the User Identification LDAP server setup.
Device Tab, under Server Profiles, select LDAP and then click on “

11

To confirm that the user database was obtained from the agent, run this command:

IDs will appear in the Monitor tab -> Traffic log in the source

we have gotten the basic User-ID working we next need to create an LDAP
Server Profile we will use later for the User Identification LDAP server setup.
Device Tab, under Server Profiles, select LDAP and then click on “New”

To confirm that the user database was obtained from the agent, run this command:

> Traffic log in the source-user

create an LDAP
Server Profile we will use later for the User Identification LDAP server setup. From the

”
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Fill in the same information that you did when setting up the User Agent. Make sure that
SSL is enabled and the port is set to 636. eDirectory does not allow passwords to
in the clear.

15. For the final step we need to define the LDAP server
information.2 Select the User Identification icon under the Device tab. Choose “
give the server a name and select the Server Profile you
group or user profile if desired (we will give an example of this later). These limit the
users and groups that the firewall learns about for use in policy.

For eDirectory we do not need to complete any of the other fields.

2 The firewall will be retrieving object class cn=group.
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Fill in the same information that you did when setting up the User Agent. Make sure that
SSL is enabled and the port is set to 636. eDirectory does not allow passwords to

we need to define the LDAP server to be able to retrieve the group
elect the User Identification icon under the Device tab. Choose “

give the server a name and select the Server Profile you just created. You can create a
group or user profile if desired (we will give an example of this later). These limit the
users and groups that the firewall learns about for use in policy.

For eDirectory we do not need to complete any of the other fields.

The firewall will be retrieving object class cn=group.

Fill in the same information that you did when setting up the User Agent. Make sure that
SSL is enabled and the port is set to 636. eDirectory does not allow passwords to be sent

to be able to retrieve the group
elect the User Identification icon under the Device tab. Choose “Add”,

You can create a
group or user profile if desired (we will give an example of this later). These limit the
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16. Commit your changes. The group information is now being retrieved from the directory.
It may take a while to populate the group and user information.

17. Confirm that the firewall is communicating with the LDAP server, and that group
information was retrieved:

18. Once the group and user information is
policy. To confirm, go to the Policies tab, click in the source
screen that appears, groups should appear.

13

. The group information is now being retrieved from the directory.
It may take a while to populate the group and user information.

nfirm that the firewall is communicating with the LDAP server, and that group
eved:

Once the group and user information is retrieved, then that information can be used
To confirm, go to the Policies tab, click in the source-user column, and in the

screen that appears, groups should appear.

. The group information is now being retrieved from the directory.

nfirm that the firewall is communicating with the LDAP server, and that group

can be used in
user column, and in the
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Part 2: Using the LDAP serv
VPN, or firewall GUI access

For situations where we need to actually challenge users for a username and password, we can
now use LDAP. There are three basi
add an LDAP server under the User Identification section, create an Authentication profile using
the defined LDAP server.

In this example we will connect to Active Directory using LDAP.

1. Under the Device tab select the LDAP option under Server
the server. As in our previous example

Unfortunately we cannot find the
if you go into Active Directory’s Users and Computers you
directory. In the example below the base would be

14

Part 2: Using the LDAP server for authentication with captive portal, SSL
VPN, or firewall GUI access

For situations where we need to actually challenge users for a username and password, we can
now use LDAP. There are three basic steps involved: add an LDAP server under Server Pro
add an LDAP server under the User Identification section, create an Authentication profile using

In this example we will connect to Active Directory using LDAP.

Under the Device tab select the LDAP option under Server Profiles. Click ”New” to add
the server. As in our previous example, fill in all the necessary information.

Unfortunately we cannot find the Base using the method we did for eDirectory. However
if you go into Active Directory’s Users and Computers you can see the base of the
directory. In the example below the base would be dc=swartz,dc=local

er for authentication with captive portal, SSL

For situations where we need to actually challenge users for a username and password, we can
c steps involved: add an LDAP server under Server Profiles,

add an LDAP server under the User Identification section, create an Authentication profile using

Profiles. Click ”New” to add
fill in all the necessary information.

using the method we did for eDirectory. However
can see the base of the
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In order to find Bind DN
Computers then once you get you results from the
Add the X500 distinguished name.

With this information we can now finish our configuration.

15

Bind DN you can do a search for the User while still in Users and
once you get you results from the View menu select Choose Col

X500 distinguished name. The results would look similar to the following:

With this information we can now finish our configuration.

you can do a search for the User while still in Users and
Choose Columns.

The results would look similar to the following:
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Note that in this example we are setting it up without SSL encryption over port 389.
Active Directory does not require encryption and it is not available by default. If you
want to enable SSL for LDAP in Active Directory the following URL can prove helpful:
http://www.linuxmail.info/enable

2. Next we add the LDAP server in the User Identification section as we did before. There
are a few differences. For Active Directory we need to specify how we determine group
and user objects. For Active Directory y

 Groups: Name=CN, Object

 Users: Name=sAMAccountName, Objects=person.

sAMAccountName corresponds to a user’s login name in Active Directory.
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Note that in this example we are setting it up without SSL encryption over port 389.
ory does not require encryption and it is not available by default. If you

want to enable SSL for LDAP in Active Directory the following URL can prove helpful:
info/enable-ldap-ssl-active-directory/.

Next we add the LDAP server in the User Identification section as we did before. There
are a few differences. For Active Directory we need to specify how we determine group
and user objects. For Active Directory you can set the fields as follows:

Groups: Name=CN, Objects:=group, Members=member

Name=sAMAccountName, Objects=person.

corresponds to a user’s login name in Active Directory.

Note that in this example we are setting it up without SSL encryption over port 389.
ory does not require encryption and it is not available by default. If you

want to enable SSL for LDAP in Active Directory the following URL can prove helpful:

Next we add the LDAP server in the User Identification section as we did before. There
are a few differences. For Active Directory we need to specify how we determine group

corresponds to a user’s login name in Active Directory.

http://www.linuxmail.info/enable-ldap-ssl-active-directory/
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Notice the group filter: description=AccessGroup
users that the firewall will learn about and therefore
policies.

In the following example
Here is a before and after lo
changes before adding this setting and then after).
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description=AccessGroup. This limits the number of groups
the firewall will learn about and therefore are available for use in creating

In the following example I had set the description fields on the groups I wanted to use
Here is a before and after look at the effect of this setting (obviously I committed my
changes before adding this setting and then after).

limits the number of groups and
for use in creating

ups I wanted to use.
ok at the effect of this setting (obviously I committed my
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The User filter can be used to restrict the

These filters only control the groups you see or users you ca
List in an Authentication Profile or when setting a source user or group in policy.

Note: Domain Users is a special group in A
schema with the attribute primaryGoup
query, as the member attribute is not set for this group so it can
usernames.

You can learn more about building LDAP queries at the following sites:

http://www.rfc-editor.org/rfc/rfc2254.txt

http://www.zytrax.com/books/ldap/apa/search.html
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The User filter can be used to restrict the users that you will learn about.

These filters only control the groups you see or users you can search for when setting an Allow
List in an Authentication Profile or when setting a source user or group in policy.

: Domain Users is a special group in Active Directory users are tied to it as part of the user
primaryGoupID . Members cannot be enumerated via an LDAP

attribute is not set for this group so it cannot be used to learn all of the

You can learn more about building LDAP queries at the following sites:

editor.org/rfc/rfc2254.txt

http://www.zytrax.com/books/ldap/apa/search.html

n search for when setting an Allow
List in an Authentication Profile or when setting a source user or group in policy.

ctive Directory users are tied to it as part of the user
not be enumerated via an LDAP

to learn all of the

http://www.rfc-editor.org/rfc/rfc2254.txt
http://www.zytrax.com/books/ldap/apa/search.html
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3. The final step is to create an Authentication Profile using our LDAP
Device tab select the Authentication Profile icon
name set Authentication to LDAP, select the Server Profile you created and set the login
attribute. This maps the name entered by the user to an LDA
sAMAccountName.

4. Next you will want to edit the Allow List to specify the groups and users that can use this
method of authentication. Note: as of this writing you must specify each user you want
to provide administrative access

You can now use this profile for administrative access, Captive Portal or SSL VPN
access as you previously could for RADIUS or a Local User Database.

Following is a screenshot of an SSL VPN profile using LDAP.
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The final step is to create an Authentication Profile using our LDAP server. From the
Device tab select the Authentication Profile icon and choose “New”. Give the profile a
name set Authentication to LDAP, select the Server Profile you created and set the login
attribute. This maps the name entered by the user to an LDAP attribute. For AD we use

Next you will want to edit the Allow List to specify the groups and users that can use this
method of authentication. Note: as of this writing you must specify each user you want
to provide administrative access for).

You can now use this profile for administrative access, Captive Portal or SSL VPN
access as you previously could for RADIUS or a Local User Database.

Following is a screenshot of an SSL VPN profile using LDAP.

server. From the
”. Give the profile a

name set Authentication to LDAP, select the Server Profile you created and set the login
P attribute. For AD we use

Next you will want to edit the Allow List to specify the groups and users that can use this
method of authentication. Note: as of this writing you must specify each user you want

You can now use this profile for administrative access, Captive Portal or SSL VPN
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One advantage of using LDAP fo
directory service that supports LDAP so nothing needs to be installed or configured. Also since
we allow the user to define how to determine both groups and users it should work with almost
any LDAP compatible directory.
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of using LDAP for authentication is that for most organizations already have a
directory service that supports LDAP so nothing needs to be installed or configured. Also since
we allow the user to define how to determine both groups and users it should work with almost

y LDAP compatible directory.

r authentication is that for most organizations already have a
directory service that supports LDAP so nothing needs to be installed or configured. Also since
we allow the user to define how to determine both groups and users it should work with almost
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Appendix A

Overview of the Lightweight Directory Access Protocol

Lightweight Directory Access Protocol (LDAP) is an open standard for providing directory
services via IP networks. LDAP is based upon X.500, the OSI Directory Access Protocol, and
was first described in RFC1487. The most recent version (version 3) is described in RFC2251.

There are two main components to an LDAP database that we must understand in order to use it
for authentication, its structure and its contents.

LDAP is a hierarchical database structure that lends itself to defining organizations and their
structures. It is incredibly flexible is design, because of this each organization’s LDAP structure
will differ.

The contents of the directory are defined in its schema that is highly extensible. Users can
modify the database design to meet their needs. The directory schema defines the possible
database objects and attributes that they can possess.

When viewing a directory, it is common to view it as a collection of container objects
(organizations, organizational units) and leaf objects (people, computers).

RFC 2377 defines the basic schema for directory-enabled applications. Following is a list of
some of the ones that are important to us.

Terminology

rdn Relative distinguished name is the name of an object without reference to its place within
the tree. It is often based upon the object’s common name.

dn Distinguished Name is the name that defines an object by indicating its location within
the directory hierarchy. It is created by concatenating the relative distinguished names of the
object and each of its ancestors up to the root of the directory partition. This name is unique
across the entire directory

base DN Each directory is required to provide basic directory specific information so that
clients can access them. One of these attributes is the list of base distinguished names (DN) that
you can access on this server. Typically the base DN will be the various domain components of
the directory.

cn Common Name is typically used to reference objects, as it is an attribute that all leaf
objects possess. The common name need only be unique within its own container (so it is
possible to have two objects with the cn of Bob as long as they are in separate containers. This
attribute can contain the users login name.

o Organization is many times the root of a directory. Below the organization will be the
various organizational units, groups, and members. eDirectory uses this as the base of its
structure.
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ou Organizational Unit is used to help define the structure of the organization A directory
can be comprised of multiple organizational units on any level of the tree.

dc Domain Component defines the top level portions of the directory and is based upon the
organization’s DNS domain name. Active Directory uses this format.

member Attribute of a group object that contains all of the members of a group. The firewall
uses this attribute to determine if a user is in a static group.

LDAP Browsers

Softerra LDAP Administrator is an excellent LDAP tool for Windows. It can be found at:
http://www.ldapadministrator.com/. Note that after initial free use you will need to buy it to
continue using it.

JXplorer is a free Java based browser that works on Windows, Mac and Linux. It can be found
at: http://jxplorer.org/.

LdapBrowser by IIT Engineering is another free java based browser that can be found here:
http://www.brothersoft.com/ldap-browser-14779.html

http://www.ldapadministrator.com/
http://jxplorer.org/
http://www.brothersoft.com/ldap-browser-14779.html

